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1. Getting Started with Word

Microsoft Word is aword processing application that allows you to create a
variety of documents, including letters, resumes, and more. In this lesson, you'll
learn how to navigate the Word interface and become familiar with some of its
most important features, such as the Ribbon, Quick Access Toolbar,
and Backstage view.

Word is similar to Word 2013 and Word 2010. If you've previously used either
version, then Word should feel familiar. But if you are new to Word or have more
experience with older versions, you should first take some time to become
familiar with the Word interface.

The Word Interface

When you open Word for the first time, the Start Screen will appear. From here,
you'll be able to create a new document, choose a template, and access

your recently edited documents. From the Start Screen, locate and select Blank
document to access the Word interface.

- Document] - Word A\ Sanjay Satapathy ﬂ = =

Insert Design Layout References Mailings Review View Help doPDF 11 ACROBAT Q Tell me

[Calibri Body)  ~|[11 -] A A7 A2~ | A AaBbCcDC | AaBbCcDe AaBbC( |
Paste | B I U v oameox, x| A~ . A - TMormal | T No Spac... Heading1 |=| | E4iting
Clipboard ™= Font = Paragraph = Styles = ~
T |-2-|-1-|-:>i<;-|-1-|-1-|-3-|-4-|-5-|-{--|-7-|-&-|-9-|-1G-|-11-|-12-|-13-|-14-|-15-|-,;J-|-1.7-|-18-
=]
~
~
&
i
-
i~
G [=]
Page 1of 1 Owords  English (United Kingdom} % Accessibility: Good to go [E 5] B - + 100%

1.1. Working with the Word environment

Like other recent versions, Word continues to use features like the Ribbon and
the Quick Access Toolbar—where you will find commands to perform common
tasks in Word—as well as Backstage view.
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1.1.1. The Ribbon

Word uses atabbed Ribbon systeminstead of traditional menus.
The Ribbon contains multiple tabs, which you can find near the top of the Word
window.

= Do ord
Home ESig o es g
B, | Calibri (Body) 1 <|iEs EEL N | EE =
K By B I U mex, x & EBE=== 1= AaBbCcDc AaBbCchi
F‘E'StE ¢ Q- PV S _ﬂ_) - 2l q [ TMormal | Mo Spacing
Clipboard 1= Font T Paragraph T Styles

Each tab contains several groups of related commands. For example, the Font
group on the Home tab contains commands for formatting text in your document.

Document] - Waord

Insert Design

Calibri (Body)

Ly X -1 =

h mls 7 u e AaBbCcDe  AaBbCchc
Pafte vl m. . A < | # W | Thormal | No Spacing
Clipboard & Font | Styles

Layout References Mailings Review View

Some groups also have a small arrow in the bottom-right corner that you can click
for even more options.

L

-

Paste

Clipboard =

-

Calibri (Body)
B I U ~ abe x, X°
. ¥ | A A A - Aa-

Font

e oo

Document] - Word

Layout References Mailings Review View

a AaBbCcDc¢  AaBbCcDc
e . TMormal | Mo Spacing
] Paragraph G Siyles
Iéont (Ctrl+D)

Customize your text using advanced
font and character options to give it
the exact look you want.

You can-add a variety of styles and
colors to your text, as well as visual
effects, like stnkethrough,
superscript, and all caps.

1.1.2. Showing and hiding the Ribbon

If you find that the Ribbon takes up too much screen space, you can hide it. To do
this, click the Ribbon Display Options arrow in the upper-right corner of the
Ribbon, then select the desired option from the drop-down menu:
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Wiewy [ e Auto-hide Ribbon

Hide the Ribbon. Click at the top

AaBbiel of the application to show it.

=— Show Tabs

Show Ribbon tabs only. Click a
tab to show the commands,

Mo Spacit

Styles
' 5 FI: Show Tabs and Commands

= Show Ribbon tabs and
commands all the time,

Auto-hide Ribbon:

Auto-hide displays your document in full-screen mode and completely hides the
Ribbon from view. To show the Ribbon, click the Expand Ribbon command at the
top of screen.

Show Tabs:

This option hides all command groups when they're not in use, but tabs will
remain visible. To show the Ribbon, simply click a tab.

Show Tabs and Commands:

This option maximizes the Ribbon. All of the tabs and commands will be visible.
This option is selected by default when you open Word for the first time.

1.1.3. Using the Tell me feature

If you're having trouble finding command you want, the Tell Me feature can help.
It works just like a regular search bar: Type what you're looking for, and a list of
options will appear. You can then use the command directly from the menu
without having to find it on the Ribbon.

Document] - Word £} L)

Rewiew View Y add page numbers Olenna Mason

= %l ar ol @ Add Page Mumbers [:,\? 3 B Top of Page » |-
_______ [ AddaBlank Page [El Bottom of Page F e
L - o T D Insert Table of Figures @ Page Margins P
= [ AddaHeader * | [ Current Position [
"""" 3o 1 Insert Index Erg Format Page Mumbers...
0 Get Help on "add page numb... E;k Eemowe Page NMumbers
ﬂ) Smart Lockup on "add page ...

1.2. The Quick Access Toolbar

Located just above the Ribbon, the Quick Access Toolbar lets you access common
commands no matter which tab is selected. By default, it shows the Save, Undo,
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and Redo commands, but you can add other commands depending on your
needs.

To add commands to the Quick Access Toolbar:

1. Click the drop-down arrow to the right of the Quick Access Toolbar.

M | Calibri (Body) ~ |11 =

Paste i~ B I U ~ak X, X°

Chipboard Font

2. Select the command you want to add from the menu.

Customize Quick Access Toolbar

o MNew E_

D Calibri (Bog E i
Open

Paste = =

= «w B I U «  Save =
Clipboard T Emnail

L Quuick Print .

o Print Preview and Print

Spelling & Grammar
i « Undo
« Redo
Draw Table
Touch/Mouse Mode
More Commands..,

3 Show Below the Ribbon

3. The command will be added to the Quick Access Toolbar.

Calibri (Body) - |11

U - abe ¥, ¥°
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1.2.1. The Ruler

The Ruler is located at the top and to the left of your document. It makes it easier
to adjust your document with precision. If you want, you can hide the Ruler to
create more screen space.

To Show or Hide the Ruler:

1. Click the View tab.

Eﬁp = Document] - Word
Insert Design Layout References Mailings Review View @ Tell me
— - L - — 31— 11— —_—— A
D Calibri (Body} |11 ~|A A |Aa~ |d@ |i=-i=~%=y | €E€3= 2| | O AaBbCcDo Aa
F'avs.te ¢ B I U-axx x° A--A- === 1=-|d-H~ TMormal | Mo
Clipboard = Font P Paragraph T
2. Click the checkbox next to Ruler to show or hide the Ruler.

= - Eﬂr, * Document] - Waord

File Home Insert Design Layout References Mailings Review View @ Tell me

D I:I D{é‘ggr::tine %ﬂuler q _) [ One Page DE

TMGridlines —E0 [ pultiple Pages

Read ['Prnt @ Web ) o Zoom 100% ) Mew Arrange Split
Mode |Layout Layout _| Mavigation Pane Ll Page Width Windaw Al
Wiews Show Zoom

1.2.3. Backstage view

Backstage view gives you various options for saving, opening a file, printing, and
sharing your document. To access Backstage view, click the Filetab on
the Ribbon.

D Calibri (Body) - /11 - | A

Past 2
aste o B I U ~abex X

-

Clipboard = Font

Click the buttons in the interactive below to learn more about using Backstage
view.
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Document] - Ward ? - O x

Olenna Mason

Issues

Q
Manage

Document ~
Account

Options

Document properties and
author's name

Manage Document

Check in, check out, and recover
unsaved changes.

_j There are no unsaved changes.

Related Dates
Last Modified
Created

Last Printed

Related People
Author

Last Modified By

Protect Document Properties ~
:’ Control what types of changes people Size Mot saved yvet
Pratect can make to this document. P b ’
Document = ages
Words 0
Total Editing Time 18 Minutes
Title Add a title
A Inspect Document )
) A e Tags Add atag
= Before publishing this file, be aware .
Check for e et s Comments Add comments

Today, 10:50 AM

“| Olenna...

Add an author

Not saved yet

Show All Properties

1.2.4. Document Views and Zooming

Word has a variety of viewing options that change how your document is
displayed. You can choose to view your document in Read Mode, Print Layout,
or Web Layout. These views can be useful for various tasks, especially if you're
planning to print the document. You can also zoom in and out to make your
document easier to read.

1.2.4.1. Switching Document Views

Switching between different document views is easy. Just locate and select the
desired document view commandin the bottom-right corner of the Word
window.

Read Mode:

This view opens the document to a full screen. This view is great for reading large
amounts of text or simply reviewing your work.
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Academic Paper - Word

without whom the SR would not have been able to solicit and select the excellent writers that
have graced their pages during these past decades. For the last seventy-sx years, the office of the
SR has housed only five, with the most recent editor, George Core, beginming his run 1n 1973,
Andrew Nelson Lytle, one of the South’s more distinguished (and underappreciated) men of let-
ters, edited the Sewanee Review twice in his career, once in 1942 to 44 and then again from 1961
to 1973 During his tenure as editor, Lvtle helped to resurrect the magazine from academic stag-
nation, financial straits and a dwindling readership while presenting some of the twentieth cen-

tury’s finest critics, writers and poets.

Read Mode

Screen 2 of 77 %E} B -1 + 100%

Print Layout:

This is the default document view in Word. It shows what the document will look
like on the printed page.

Academic Paper - Word ca) - | x

Home Insert Design layout  References  Mailings  Review  View ¥ Tellme.. OlennaM... (’q_ Share

Times 2
D B|T U ~abcx, x> %
Paste "0 |llo0 i o
¥ A-W-A-ha- KA

Clipboard = Fant P Paragraph G Styles = F

L0
Editing

AaBbCecl AaBbCcl AaBbCcl

THeading1 TMNormal T MNoSpac.. |+

L | . . . . S W T SR B T N S A R e, 0 B
4 & =

the time. Indeed, a great deal of the magazine’s continued excellence has depended on its editors,
without whom the SE would not have been able to solicit and select the excellent writers that

I have graced their pages during these past decades. For the last seventy-six vears, the office of the
: SR has housed only five, with the most recent editor, George Core, beginning his run in 1873,
Andrew Nelson Lytle, one of the South’s more distinguished (and underappreciated) men of
letters, edited the Sewanee Review twice in his career, once in 1942 to 44 and then again from

& 1841 to 1973, During his tenure as editor, Lvtle helped to resurrect the magazine from academic

stagnation, financial straits and a dwindling readership while presenting some of the twentieth -
4] . ] . |Print La'_-,-'out_- | '
Page 1 of 23 ES E‘h B - } + o0

Web Layout:

This view displays the document as a webpage, which can be helpful if you're
using Word to publish content online.
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(L) = Academic Paper - Word Eal - [m| x

Home Insert Design Layout References Mailings Review View ¥ Tellme.. OlennaM.. 2_ Share

Times o
D s x < | A AaBbCcl AaBbCcl AaBbCcl —
Pavste C A-Aa-| K & THeading1 T MNormal 1T MNoSpac.. |+ Ed'Emg
Clipboard = Font ] Paragraph r Styles (1 M

o ---?---1---|---2---|---3---|---4---|---5---|---6---|---?--(_\-|-
%ewanee Review. Founded in 1892, the Sewanee Review (SR) has never missed an 1ssue, distinguishing it as

the oldest continuously published quarterly review in the United States. For its first half-century, the
magazine existed as a general journal of the Humanities, featuring articles on literature, art, politics, and the
South. In the early 1940s its focus became purely literary, and the SR now regularly publishes superb essays,
literary criticism, fiction, poetry and, of course, reviews of current books. This shift in tone was facilitated
expressly by the editors of the time. Indeed, a great deal of the magazine’s continued excellence has
depended on its editors, without whom the SR would not have been able to solicit and select the excellent

writers that have graced their pages during these past decades. For the last seventy-six "ﬂ;f[ +ha office of the
Web Layout

& By - 1 +  100%

1.2.4.2. Zooming in and out

To zoom in or out, click and drag the zoom control slider in the bottom-right
corner of the Word window. You can also select the + or - commands to zoom in
or out by smaller increments. The number next to the slider displays the
current zoom percentage, also called the zoom level.

s of the time. Indeed, a great deal of the magazine’s
ed on its editors, without whom the SR would not have

excellent writers that have graced their pages during  Zocomin

& & - i i 1205
2. Creating and Opening Documents

Word files are called documents. Whenever you start a new project in Word,
you'll need to create a new document, which can either be blank or from a
template. You'll also need to know how to open an existing document.

2.1. To create a new blank document:

When beginning a new project in Word, you'll often want to start with a new
blank document.

1. Select the File tab to access Backstage view.
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Design Layout

B Calibri (Body) ~[11 -
Cop
Past = 2
af - ~ Format Painter AR L ot X
Clipboard P Font
2. Select New, then click Blank document.
New
Search for online templates Fel
Suggested searches:  Business  Personal Industry  Print
Design Sets  Education  Event
; ©
Take a
tour
fee Blank document Welcome to Word
Options
Aa Title (]
3. A new blank document will appear.
2.2. To create a new document from a
template:

A template is a predesigned document you can use to create a new document
quickly. Templates often include custom formatting and designs, so they can save
you a lot of time and effort when starting a new project.

1. Click the File tab to access Backstage view, then select New.

2. Several templates will appear below the Blank document option. You can
also use the search bar to find something more specific. In our example, we'll
search for a flyer template.
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New

flyer| o

Suggested searches:  Business  Personal  Industry  Print

Design Sets  Education  Event

Take a
tour

Account
Blank document Welcome to Word
Options
3. When you find something you like, select a template to preview it.
£ Home | fiyer L
summer splash fall horyest -

celebration celebration

[DATE]
[EVENT
TITLE HERE]

Seasonal event flyer Summer event flyer

IRHUARY 28™ 2013
SKI WORKSHOP AND
EQUIPMENT SALE

Seasonal event fiyer (spr... Seasonal event flyer (wi... Seasonal event fiyer (au.. -®

4. A preview of the template will appear. Click Create to use the selected
template.
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Seasonal event flyer

(autumn)
Provided by: Microsoft Corporation

Add Key Event Info

Here! Announce your company event with this fall
seasonal event flyer with a color block design,
Don't Be Shy—Tell Customize the look by replacing the photo with
Them Why Thay your own, of use this template as is by simply
Can't Miss it! filling in your information, Find similar flyers for

other seasons by clicking the See Also links above.
One More Point

Here! Download size: 803 KB

Add More Great

SUBTITLE for Acther Ore cgm 3
TITLE

‘Heading

Tio get started right away, jut tap any placehoider text (such &
‘this) and sTart tyDing £0 PeStEce R with your own Want to inuer s
pictare from your files or #6d & shape, text Box, or table? You got
O tha Insert tab of the nbbon, ust tap The optior you need.

LOGO

5. A new document will appear with the selected template.

You can also browse templates by category after performing a search.

|~ Category
:.J'Ig;:ilt;?:l1:i[}rl . T {"'j L
L1 Event 04
Personal e
Announcements 65
Blue 50
Business 46
Party 46
Education 43
Event Planning 42
Industry 42
Media 37
Print 34
Invitations 33
SUBTITLE [ustration 32
TiTiE ' Holiday 3
Posters 29
Advertisements i}
Partrait 25
Seasonal event flyer (au...
Seasonal 25
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2.3. To open an existing document:

In addition to creating new documents, you'll often need to open a document
that was previously saved. To learn more about saving documents, visit our lesson

on Saving and Sharing Documents.

1. Navigate to Backstage view, then click Open.

Document] - Waord

Info

Protect Document

} Control what types of changes people can make to this
Protect
Document ~
m_] Inspect Document
&)
T Before publishing this file, be aware that it contains:

Check for

i Document properties and author's name
ssilies ™

2. Select This PC, then click Browse. Alternatively, you can
choose OneDrive to open files stored on your OneDrive.
@ Recent Documents
OneDrive - Personal Adworks
ﬁ lakestone.omason@gmail.com
= Custom Office Templates
El:l This PC
My Snips
== Add a Place
School
Browse Tax Forms
s =
m§| Monthly Report.docx
Account —
ﬁ_§| Org Chart.docx
Options —
3. The Open dialog box will appear. Locate and select your document, then

click Open.
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CEl open X
= v » ThisPC » Documents * School w 0 Search Schoal o
Organize v MNew folder ==« [H 9
[ Desktop ¢ Name Date rmadified Type Size
& Downloads 1 Bio Notes 12/10/15 12:05 PM 20 kB
=] Documents 1% Humanities Essay 12/9/15 AM 326 KB
D Music . 1%} Term Paper I 11/30/15 12:33 PM 45 KB
= | Pictures d
v < >
File name: |Term Paper V| All Word Documents w
Tools - Cancel

4. The selected document will appear.

2.4. To pin a document:

If you frequently work with the same document, you can pin it to Backstage view
for quick access.

1. Navigate to Backstage view, click Open, then select Recent.

2. A list of recently edited documents will appear. Hover the mouse over
the document you want to pin, then click the pushpin icon.

Open

( L) Recent Older
m— ResumeCoverLette.r 127472015 331 M
=| Dlenna Mason's OneDrive
(5 OneDrive - Personal

= === Memo
lakestone.omason@gmail.com =

; 12/1/2015 3:04 PM
Olenna Mason's OneDrive » Documents

| Resume
-|  Olenna Mason's OneDrive » Documents

ED This PC

5/12/2014 233 PM 'h

Add a Place

Browse

3. The document will stay in Recent documents list until it is unpinned.
To unpin a document, click the pushpin icon again.

Open

(T) Recent Pinned
== Resume
= 12/2014 2:33 PM
h_ Olenna Mason's OneDrive » Documents i h

&& OneDrive - Personal
& e
lakestone omason@gmail.com Older

== ResumeCoverLetter Sa
E= . =| 12/4/20153:31 PM
ELI:I This PC m | Olenna Mason's OneDrive .
O
S e 12/1/2015 304 PM
f‘;‘_f* Add a Place =  Olenna Mason's OneDrive » Documents

Browse
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3. Saving and Sharing Documents

When you create a new document in Word, you'll need to know how to save it so
you can access and edit it later. As with previous versions of Word, you can save
files to your computer.If you prefer, you can also save files tothe
cloud using OneDrive. You can even Export and Share documents directly from
Word.

3.1. Save and Save As

Word offers two ways to save a file: Save and Save As. These options work in
similar ways, with a few important differences.

Save:

When you create or edit a document, you’ll use the Save command to save your
changes. You’ll use this command most of the time. When you save a file, you’ll
only need to choose a file name and location the first time. After that, you can
click the Save command to save it with the same name and location.

Save As:

You'll use this command to create acopyof a document while keeping the
original. When you use Save As, you'll need to choose a different name and/or
location for the copied version.

3.1.1. To save a document:

It's important to save your document whenever you start a new project or make
changes to an existing one. Saving early and often can prevent your work from
being lost. You'll also need to pay close attention to where you save the
document so it will be easy to find later.

1. Locate and select the Save command on the Quick Access Toolbar.

-

Insert Design Layout

Calibri (Body} ~{11 -

Paste it > 3
. %' Format Painter A& e X X
Clipboard ) Font

2. If you're saving the file for the first time, the Save As pane will appear

in Backstage view.
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3. You'll then need to choose where to save the file and give it a file name.
Click Browse to select a location on your computer. Alternatively, you can
click OneDrive to save the file to your OneDrive.

Save As

6 OneDrive - Personal

lakestone.omason@gmail.com

EI;I This PC
o= AddaPlace
Browse
by
4. The Save As dialog box will appear. Select the location where you want to
save the document.
5. Enter a file name for the document, then click Save.

[E] save As x
e v » ThisPC » Desktop » AdWorks v 0 Search Ad Works R
Organize New folder fzz - e

_'—:'| Documents  # Mame - Date modified Type Size
D Music M) AdWorks Letter 11/30/15 3:00 PM Microsoft Word Doc.., 15 KB
&= | Pictures
B videos
Ad Works ol 3
File name: m v
Save as type: | Word Document ~
Authors:  Qlenna Mason Tags: Add atag Title  Add a title
[] 5ave Thumbnail
. Hide Folders Toals - Cancel
6. The document will be saved. You can click the Save command again to save

your changes as you modify the document.

You can also access the Save command by pressing Ctrl+S on your keyboard.
3.1.2. Using Save As to make a copy

If you want to save a different version of a document while keeping the original,
you can create a copy. For example, if you have a file named Sales Report, you
could save it as Sales Report 2 so you'll be able to edit the new file and still refer
back to the original version.
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To do this, you'll click the Save As command in Backstage view. Just like when
saving a file for the first time, you'll need to choose where to save the file and
give it a new file name.

Resume - Word

Info

Resume
Desktop » Ad Works

Protect Document

#0 Control what types of changes people can make to this document.
Protect
Document +

Inspect Document
o Befare publishing this file, be aware that it contains:
Check for

Document properties and author's name
Issues =

3.1.3. Auto Recover

Word automatically saves your documents to a temporary folder while you are
working on them. If you forget to save your changes or if Word crashes, you can
restore the file using AutoRecover.

Enjoying the Sample!

Worg Buy the e-Book Online to continue
' the Full E-Book.

www.TallyPrimeBook.Com
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